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Lucity Pre-Conference Workshop - Basic 
Desktop Functionality 
In this workbook, we’ll introduce you to the basic layout and functionality of the Lucity desktop 
system.  This includes menus, form layout, fields, toolbars, adding/editing/deleting records, finding 
records, and filtering records.   
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Introduction to Asset Management 
The Lucity™ suite offers you a comprehensive solution for Asset Management.  Our user-friendly 
inventory and inspection modules are all structured around the basic functions discussed in the 
following pages.  These modules allow you to manage your asset inventory, assess the condition of your 
assets, and determine your maintenance needs.  Our modules have been created specifically for Public 
Works Departments and allow you to manage your water, storm, and sewer assets, transportation 
system, fleet, facilities, trees, and parks. 

System Inventory 
Each solution provides inventory modules for comprehensive data capture of your assets and their 
components.  The inventory modules consolidate asset information into a single database.  You can 
easily retrieve and analyze this data using the built-in filtering and reporting capabilities.  Additionally, 
each solution provides functionality designed specifically for the assets you are managing.  For 
example, the Pavement module provides you with maintenance forecasting and budget forecasting 
capabilities, while the Tree module allows you to create a library of scientific information about the 
trees in your system, as well as determine the value of each tree using two distinct valuation methods. 

Field Inspection 
Most inventory modules have corresponding inspection modules that allow you to manage your system’s 
condition assessment data.  These modules are fully integrated.  Physical data in the inventory 
databases links directly to the inspection modules.  When you correct discrepancies in the inspection 
modules, the inventory data automatically adjusts.  By compiling and analyzing inspection data, you 
can detect trends in system performance and organize rehabilitation plans for maximum efficiency. 

Introduction to Work Management 
The Lucity™ suite also offers you a comprehensive solution for Work Management.  The Lucity Work 
module allows you to track customer requests, create work orders, establish a preventative 
maintenance plan, set priorities, provide timetables, track system rehabilitation, manage work 
projects, and perform budget forecasting. 

Work Orders 
The Work Orders module allows you to schedule and track work tasks, personnel, equipment, and 
material usage.  Three versions of work orders are offered on the desktop:  Standard, Lite, and Daily 
Work.  All three modules integrate with the same data set.  The Standard module is the most 
comprehensive of the three, offering additional functions such as costing, billing, and tracking.  Work 
Order Lite contains only the basic functions of the Work Order Standard module.  This allows for quick 
and easy data entry.  The Daily Work module is the most basic of the three, designed for quick data 
entry without your fingers ever having to leave the keyboard. 

Mobile Desktop 
Mobile Desktop allows you to upload and download work orders to and from the field as well as almost 
every Lucity inventory and inspection module.  In this manner, you can mobilize your work 
management database.  This solution is available for handheld devices, tablets and laptop PCs. 
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Menus 
The menu bar will help you navigate through the Lucity™ desktop suite.  After logging into the system, 
you’ll see a menu bar at the top of the screen: 

 

 

The menu items correspond to individual groupings in the software, system functions, and the help 
guide.  Each main menu item contains a drop down menu listing each available module.  For example, 
under the Water main menu item, you can see a list of all modules that help maintain different types 
of Water assets. 

 

 

Although the menu bar contains all of the capabilities and programs offered by Lucity, only those 
purchased will be accessible.  If you click on a program that you have not purchased, a drop-down 
menu will appear; however, the menu items will be disabled (grayed out). 

 

Form Layout 
Each application in the Lucity™ desktop suite has a window designed specifically for the information 
recorded in that module.  Although each module has a unique window, the components that make up 
each window are the same.  This helps make the desktop easy to use.  The basic components of each 
window are the Module Toolbar, Header Data, Fields, Field Captions, Attribute Tabs, and the Status 
Bar.  We’ll discuss each of these components in the following pages using the Water Hydrant Inventory 
module as a guide. 

 

 

Notes:___________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 
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Module Toolbar 
At the top of each window you’ll see a Module Toolbar.  

 

 

This contains buttons that perform or access a variety of standard functions.  Place your cursor over an 
icon to see the name/function of that particular toolbar button.  For example, if you place your cursor 
over the icon that resembles a printer, the words “Print Module Window” appear.  

 

Each module’s toolbar may vary.  There may be 
instances where buttons appear to be “grayed out” or 
disabled.  These buttons are inaccessible for that 
module; nothing will happen when they are clicked.  
Some buttons, such as the Toolkit button, will appear 
in modules only when the functionality is applicable for 
that module. 

 

Toolbar Buttons 

Button Name Description 

 
Resize Resizes the module window. 

 
Print Module 
Window 

Captures the screen image and sends it to your designated 
printer. 

 
Locate Quickly locates specific records. 

 Browse Browses records, produces quick, custom reports, and 
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exports information. 

 Filter Opens the Filter window. 

 Reports 
Views, prints, or adds/deletes reports to or from the list of 
pre-defined reports. 

 
Open Document 

Views a list of documents, videos, and images attached to 
the record. 

 
Document Control 

Adds or deletes documents, videos, and images to or from 
the record. 

 
Save Saves your changes. 

 Cancel Cancels any changes you have made since the last save. 

 
Add Record Adds a new record to the module. 

 
Edit Edits the current record. 

 Delete Deletes the current record. 

 
First, Previous, 
Next, Last 

Navigates through the data set. 

 Go To Views a specific record number. 

 
Refresh 

Re-queries the data set and returns your screen to the first 
record in the filtered set (i.e., it runs the filter again). 

 
Relationship Displays other modules related to the current record. 

 
Subsets Creates and saves a set of filtered records. 

 
Work Order Generates a Work Order for the current record. 

 
Work Request Generates a Work Request for the current record. 

 
PM/Template Generates a PM/Template for the current record. 

 
Toolkit 

Opens the Toolkit dialog box.  The existence of this button 
and the options inside the Toolkit dialogs vary by module. 

 
Show In Map Opens GIS, zooms in, and highlights the selected feature. 

 Recalculate Updates all calculations in the module. 

 Help 
Opens the Lucity Help Guide to the appropriate topic 
chapter. 

 Close Closes the module. 
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Header Data 
At the top of the module window you will see header data.  This is visible regardless of which tab is 
displayed below.  It is important to enter data in the header for each new record because this 
information defines or distinguishes each record using unique IDs. 

 

 

Header data varies with each module.  In most modules the header data consists of an ID number or 
some other number that identifies the asset represented in that record.  Many modules have required 
fields in the header, meaning a record cannot be saved until data is entered in these fields.  You will 
receive an error message if you attempt to save the record without the required information. 

 

 

 

Notes:___________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 
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Tabs 
Each module on the desktop has various tabs to organize and store similar types of data.  You can see 
on the screen below that the Water Hydrant Inventory module has tabs for Attributes, Location, 
Construction, Flow Tests, Inspections/Associations, Flushing, Work Orders/Preventative 
Maintenance/Requests (WO/PM/Req), Custom, and Comments.  Although tabs vary by module, each 
module typically has Custom and Comments tabs.  To navigate through the record, click on the tab 
names.  The display will change accordingly. 

 

 

For modules that have too many tabs to fit on one screen, a right and left arrow will appear to allow 
for navigating through the tabs:   
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Status Bar 
The status bar, located at the bottom of the module window, performs a variety of functions.  It 
allows you to see what record number you are viewing as well as how many records are in the current 
set.  For example, the status bar below reads “Record 106 of 215”. 

 

 

 

The status bar also allows you to see whether the current record is in View Mode, Add Mode, or Edit 
Mode.  For example, this record is in Edit Mode.  The status bar may also display any messages 
regarding available Hot Keys or other special functions.  The status bar above tells you that by pressing 
the <F9> hot key, a pop-up list of choices will appear.  Finally, the status bar alerts you when the 
system is busy performing another function.  In this example, the status bar reads “Ready”, meaning 
the system is not performing any other function at this time. 

 

 

Notes:___________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________

_________________________________________________________________________________________ 
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Grids 
Each module on the desktop may have one or more grids that appear throughout the tabs.  For 
example, in Hydrant Inventory, there is a grid that displays the Inspections associated with the hydrant 
asset.  The inspections are considered “children” of the current hydrant.  The hydrant would be 
considered a “parent” of the inspections.  Some of the grids are also “linked” records that are related 
to the parent through special relationships.   

 

In addition, the records in the grids may have actions that can be completed on them.  To see if there 
are actions that can be performed, highlight the record in the grid and click the right mouse button.  
Any functions that are available for that record will appear.  These are also known as “Right-Click” 
functions.  For example, the “Right-Click” functions for the Hydrant Inspections are displayed here: 
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Adding, Editing, and Deleting Records 
The steps for adding a new record, editing the current record, or deleting a record are the same 
throughout the modules.  In addition to adding, editing, and deleting records through “Right-Click” 
functions in a grid, these standard functions exist when a module is opened from the menu.   

To Add a New Record: 

1. Open a module from the menu. 

2. Click  on the module toolbar to add a record.  You are now in Add Mode. 

3. Enter any Header data or required data. 

4. Enter any additional information in the Attribute Tabs. 

5. Click  to save the record. 

For example, to add a Hydrant Inspection, you can click the Add button and fill out the desired fields, 
including the required fields of Hydrant Number and Inspection Date.  You will prompted for any 
missing required fields, such as Hydrant Number: 

 

 When you add new records, a filter is automatically created with your new records created.  To 

view all records again, click the Filter button drop down list  and select Reset Filter. 

 

To Edit the Current Record: 

1. Click  on the module toolbar to edit the current record.  You are now in Edit Mode. 

2. Make the necessary changes. 

3. Click  to save your changes. 

4. Click  to exit Edit Mode or cancel your changes prior to a save.   

 

To Delete a Record: 

1. Locate the record you wish to delete. 

2. Click  to delete the record. 

3. You will receive a prompt asking you to confirm the deletion.  Take care when deleting records 
as this action cannot be undone. 

 

Your security settings may limit who can add, edit, and delete records. 
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Fields and Field Captions 
Each record contains various field types and field captions.  Fields are the locations on the window 
where data is entered.  Each field is preceded by a field caption button. 

Field captions define what information should be entered into a particular field.  For example, the first 
field caption below is labeled “Priority”.  A priority of 1 – High has been entered in the corresponding 
field. 

 

 

 

 

All fields have a field definition window and a field 
properties window.  You need to be in View Mode in 
order to see the Field Properties, Field Caption, and 
Global Edit functions.  You can access these functions by 
placing your cursor over a field and using Ctrl + Right 
Click. 

 

 

These windows allow you to view or change the field definition, change the allowable digits to the left 
and right of the decimal point in a numeric field, make field entry required or restricted, etc.  

 

Some fields are editable and others are static (meaning you cannot modify them).  Editable fields have 
a white background while static fields have a gray background.  A few special fields have a Global Edit 
option.  This option allows you to mass-populate a field in your filtered record set without having to 
update each record individually. 

 

 

 

 

 

 

Notes:___________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________

_________________________________________________________________________________________ 
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Field Instructions 
Some fields may have special function keys that are applicable to that field.  A short instruction would 
display on the status bar when the cursor is inside the field.  For example, in the inventory modules, 
there is an instruction for the main ID that allows the user to fill the field with the database record 
number using the F5 key.  This function key might be used if the user desires that the field filled with 
any unique ID when adding a new record.   

 

 

Here are some examples of fields that use the F5 key to copy a value from one field to another: 

 In Requests, from the Phone field to Home Phone, Phone 1 or 2, or Work Phone. 

 In Work Orders, from the Start Date to the End Date. 

 In Work Orders, from the Total Cost to the Billing Amount. 

 In Fleet Travel Log, from the Starting Odometer to update from the previous record. 

 

Notes:___________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________

_________________________________________________________________________________________ 
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Field Types 
There are different types of fields available for data entry.  For example, some fields require 
numerical data while others require text.  A brief definition and example of each field type is listed in 
the table below. 

Code-Description or “Picklist” 
Fields 

 

These fields require you to enter a code in the first 
box. The code description will then appear in the 
grayed-out box. For example, a code might be 
1=High, 2=Medium, 3=Low, etc. The number 1 would 
go in the first field and the description “High” 
would automatically appear in the second field. The 
codes and descriptions are created and then 
accessed through a picklist. 

Numeric Fields 

 

Numeric fields only allow a number to be entered. 
Depending on the field, the numbers may or may 
not contain decimals.  Most numeric fields are right-
justified. 

Text Fields 

 

 

Text fields allow both letters and numbers to be 
entered.  Most text fields are left-justified. 

Logical (checkbox) Fields 

 

Logical fields allow you to enter a checkmark in the 
box if you wish to select that field.  

Date Fields 

 

Date fields can be manually or automatically 
entered. To manually enter a date, use the 
mm/dd/yyyy format. Use the arrow keys in place of 
the backslash. To automatically enter the current 
date, hit the space bar while your cursor is in the 
field. You can also use the drop-down menu to 
select the date from a pop-up calendar. You can 
then use the arrow keys at the top of the calendar 
to select a different month or year.  

Time Fields 

 

Time fields can be manually or automatically 
entered. To manually enter a time, use the arrow 
keys in place of the colon. To automatically enter 
the current time, hit the space bar. To identify AM 
or PM, enter an “A” or “P” after the time or use the 
up or down arrow keys on your keyboard. 

Comment Fields 

 

Comment fields allow users to enter multiple lines 
of text in paragraph form. These comment fields 
have copy/paste abilities and carriage returns using 
Ctrl + Enter. 
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Tools 

Locate 
The locate feature allows you to quickly find specific records within the current record set.  
The following example is from the Water Hydrant Inspection module; however these same 
steps apply in all other modules.  You can use this feature if you know specific identification 

information about the record you are looking for, or if you’d like to search through a list of the records 
available. 

To access the locate feature, click  on the module toolbar. 

 

 

Your search is organized by the fields at the top of the window.  Click on the column header for the 
field you want to search by.  The selected header text will be shown in red italics and the records in 
the dialog will be sorted by that field.  In the example above, the “Hydrant Number” header is 
selected. 

You can search for a record by scrolling through the list shown or by using a dynamic search.  In a 
dynamic search you will use the text box at the top of the window to enter the information you are 
looking for.  In this example, we’ve entered “Hydrant Number to Locate” of 2428 and the system has 
found the corresponding record.  The record found by the system will be highlighted in red.   

The system will also search for partial text.  In the example above, when “24” is typed, the red line 
will jump to the first record beginning with “24”.  As you continue typing, the highlighted line will 
move to match your search item.  This function is performed automatically. 

Once you have found the record you are searching for, click , double click, or hit <Enter> on 
the keyboard.  The highlighted record will open. 
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Filtering Records 
A filter helps you narrow your search for a specific record or set of records.  You can use 
filters to find and work with only the records you want without having to work with the entire 
record set.  For instance, you may be trying to manage your Inspections, but find that you 

have to sort through other people’s records as well.  A Filter will allow you to work with only your 
desired records. 

Once you’re comfortable with filtering, you’ll be able to use filters to get a great deal of specialized 
information out of the system.  You can find assets that are costing you the most in maintenance, do 
cost and trend analyses, and much more. 

There are three ways to open the filter window: 

1. When you open a module for the first time you will be prompted to define a filter before 
any records are displayed. 

2. After a module is already opened, you can set up a filter by clicking the filter button in 

the toolbar . 

3. In the Filter drop-down list , you can select the “Filter” option.   

 

Using the Filter Window 
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Filter 

The “Filter” option is the first tab in the Filter window.  This tab contains a list of saved filters.  If this 
is your first time using the module, no filters will be saved.   

 

Sort 

 
 
The “Sort” option is the second tab on the Filter window.  THIS IS NOT A FILTER (and you can skip this 
step).  You can set up a sort order to view records in the module in ascending or descending order 
based on the field(s) you select.  To use the sort function, complete the following steps: 

1. Highlight a field in the “Selectable” list.  You can use the selection buttons at the bottom of the 
grid to change the order in which the fields appear.  “Standard Order” reflects the order in which 
the fields appear in the module itself.  If you’d prefer, you can change it to “Alphabetical” order.  

2. Click the right arrow  and the field appears in the “Selected” list.  You can select as many 

fields as you like from the list.  Use   to remove an item from the list. 
3. Click the “Ascending” or “Descending” buttons under the “Selected” list to indicate how you want 

the records sorted. 
4. Click “Reset” to clear all “Selected” fields and start over. 
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Filter Tabs 

The remaining tabs in the Filter window (Pg. 3, Pg. 4, etc.) contain all of the filterable fields.  You will 
use these tabs to set up your filter criteria. 

 

 

 

When you move through the tabs you’ll see that the fields appear in the same order as they would in 

the Hydrant Inspection module (or whatever module you are using).  The right and left arrows  at 
the top-right of the screen allow you to move through the tabs when there is more than one page of 
tabs. 

 

 

Notes:___________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________

_________________________________________________________________________________________ 
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Example Filters 

To help you better understand how to use filters, we’ll go over some specific examples.   

Filter with ‘Equals’ (Inspected By) 

You may want to view inspections that you have created in the past.   

 

1. Select the Inspected By field 

2. Select the equal option 

3. Type “Casey” in the empty field on the same line.   

These selections will set up a condition where “Inspected By = Casey”. 

 

Notes:___________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________ 
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Count Records 

  Click the Count Records button to get a count on the records that will be filtered out.  
Here we can see that 3 (out of the total 70) Inspection records have Casey in the Inspected By field.  

 

 

Go to Records 

  Now click “Go” on the filter screen and the three Inspections with Casey in the 
“Inspected By” field will be shown.  You can see the record count at the bottom of the screen (in the 
status bar). 

 

To see a list of the records, use the Locate Button .  You’ll see the filtered record set only (the 
three records found in your filter). 
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Save the Filter 

Filters can be saved for use in the future.  To save a filter, select the “Save” button if it is the first 
time you have saved the filter or “Save As” button on the Filter screen.  To replace a filter that 
already exists, click the “Save” option and you will be asked if you would like to replace the filter.  
The saved filters will appear on the filter window.  Filters saved with by the current Lucity user will 

also appear in the drop-down list next to the filter button .   

 

Filter Display Options 
The selection buttons at the bottom of the “Saved Filters” list allow you to display only your saved 
filters and indicate whether or not a default filter will be used each time a module is opened.   

1. When you select the “Skip this Screen” option, the filter form will not appear each time the 
module is opened.  Instead, the system will open the module directly to the record set.  If 
needed, you can still open the filter from the module toolbar. 

2. When the “Load Default Filter” option is selected, the system runs the filter marked as default 
each time the module is opened.  The default filter will be listed at the bottom of the screen.  
To change the default filter, highlight a different filter name in the saved filters grid and click 

the Make Default button on the right-hand side of the filter screen. Note:  Default filters are 

workstation-specific. 
3. When the “Load All 

Records” option is 
selected, the system will 
display all records each 
time the module is 
opened.  

4. When the “My Filters 
Only” option is selected, 
the saved filters grid will 
display only the filters 
saved using your Lucity 
login ID.  If this option is 
not selected, all saved 
filters, including those 
saved by other Lucity 
users, will appear in the 
grid. 

 

 

Notes:___________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________ 
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Resetting a Filter 

After running a filter, you can reset the records in the module back to the full list by selecting “Reset 
Filter” located in the Filter drop-down list.   

 

 

Advanced Filters 
If you find that one of our standard filters does not provide the necessary results, you can use an 
advanced filter.  Advanced filters are particularly useful if you want to query for null values or include 
‘or’ statements in your query.  In the following step-by-step examples, we’ll show you how to create 
some of the simplest forms of advanced filters.   

Keep in mind that for more advanced types of filters, it’s very important that you have knowledge of 
SQL syntax to create your queries.  Also, you should know that the filter syntax differs depending on 
which database you are using (Oracle, SQL Server, or Access).  Finally, reports won’t run properly with 
advanced filters.  You’ll need to define the Report SQL in order to use advanced filters in your reports.  
For additional information on our advanced filters, please consult our Lucity help guide or talk to your 
database administrator for help writing SQL queries. 

Filtering for Null Values 

In our first example, we’ll show you how to create a filter for a null value.  In other words, we’ll show 
you how to filter for a blank field.  The easiest way to create this type of advanced filter is to start 
with a standard filter. 

1. First, select a field to filter on.  We’ll use the Overall Condition (i.e., “Overall Cond”) field in 
Hydrant Inspections. 

2. Select ‘equal’ from the 
drop-down list.  Then, 
type in any value in 
the next field.  It 
doesn’t matter which 
value you type as we’ll 
be deleting it in the 
next step. 

3. Click the Advanced 
button. 
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4. In the Advanced SQL window, delete the = sign and anything after it.  Here, we’ll delete the = 
sign and ‘01’. 

 

 

 

5. Next, type IS NULL where you made the deletion.   

6. Click GO to see your filtered set.  This particular record set will contain any records where the 
Overall Condition field is null (blank). 

 

 

Filtering Using ‘OR’ Statements 

Now, we’ll show you how to alter a standard filter to include an ‘or’ statement.  This is another kind of 
advanced filter that’s really quite simple to use.  For example, you may want to use this type of 
advanced filter to find all Hydrant Inspections that have either an Overall Condition OR Operating 
Condition of Poor.  

1. On Pg. 3 of the filter screen, set the “Overall Cond Text” and “Operating Cond Text” equal to 
‘Poor’.   
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2. As the filter appears initially, it will return all records where Overall Condition AND Operating 
Condition are equal to ‘poor’.  Since we want to return records where the poor condition is 
listed in either capacity (not both), we’ll use an advanced filter.  Click the Advanced button. 

 

 

3. On the Advanced SQL tab, delete the word AND after the first ‘Poor’ condition and type OR 
instead. 

4. Add parentheses around this part of the Where-clause:  WHERE (WTHINSP.HI_PHYS_TY = 

'Poor' OR WTHINSP.HI_OPER_TY = 'Poor') 

5. You can then click the GO button to access the filtered set.  This filter will now return all 
records where the Overall Condition OR Operating Condition is Poor. 
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Reports 
Reports are a convenient way to view and organize data.  The desktop application contains a 
set of pre-defined reports in each module.  These reports can be modified using Crystal 
Reports™ software.  You can also create your own custom reports using Crystal Reports.  The 

following example is from the Hydrant Inspection module; however, these same steps apply in all other 
modules. 

A field inspector may need a report listing his/her Hydrant Inspections completed, the Hydrant 
address, and the conditions noted during the inspections.  The Lucity system contains a pre-defined 
report with just this information (the Water Hydrant Inspection Summary report). 

1. To access the report, click  on the module toolbar. 

2. The names of all pre-defined reports are listed in the Reports dialog box.  Scroll down to find 
the report you are looking for.   

3. The Report Description box at the bottom of the screen will display a brief summary of the 
highlighted report. 
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Report Filter 
Note the Report Filter box in the upper-right corner.  This feature allows you to choose which records 
will be included in the report.   

 

 

 

Note the Report Filter box in the upper-right corner.  This feature allows you to choose which records 
will be included in the report.   

 

7. If you select “This Record Only”, the report will only include the information on the current 
record. 

8. If you select “Current Filter”, the report will include all records in the current filtered set.  

9. If you select “All Records”, the report will include all records in the module. 

 

Quick Reports 
You may have some reports that are used more frequently than others.  You can save these reports as 
“Quick Reports”.  This feature allows you to select and generate a report quickly, without having to 
open the entire Report List.  Quick reports are Lucity user-specific; therefore, the Quick Report list will 
display only the reports you have saved. 
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1. Click  on the module toolbar to open the report list. 

2. Right click on the report you wish to save as a “Quick Report”. 

3. Select Add to Quick Reports, with the option to save it on this record only, the filtered data 
set, or the all the records. 

 

4. Once a report is saved as a Quick Report, a pointing hand  will appear in front of the 
report name.  Quick Reports will appear in the list when you click the drop-down arrow beside 
the toolbar button. 
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Browse 
The Browse feature is used for reporting on-demand.  It allows you to quickly generate a 
report in table format.  The following example is from the Hydrant Inspections module; 
however, these same steps apply in all other modules. 

 

1. To access the Browse function, click  on the module toolbar. 
2. Using the Browse dialog box, you can select a series of fields from the grid on the left and add 

them to the grid on the right.  This allows you to build a report for all of your records showing 
only the information you are interested in seeing.   

10. Highlight a field in the left-hand grid. 

11. Click the  button to move it to the right-hand grid. 

12. Continue adding additional fields as necessary. 
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Browse Report 

Once you have selected the fields for your Browse, click  to view the Browse report. 

 

 

 

In the example above, we’ve selected Hydrant Number, Inspection Date, Inspected By, and Overall 
Condition.  As you can see, the Browse report displays only the selected information. 

 

Saving a Browse 
If this is a Browse report you would like to use 
frequently, you can save it to your Browse list. 

1. Click the  button. 

2.   

3. Enter a name for the Browse in the field 
provided. 

 Here, we’ve named the Browse “Hydrant 
Inspection Information”. 

4. Once the Browse has been saved, the name will 
appear in the grid at the bottom left-hand 
corner of the dialog. 
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Quick Browse 

After saving a Browse, you can access it through the Quick Browse list in the menu.  All Quick Browses 
appear in the list when you click the drop-down arrow beside the toolbar button. 

 

 

Document Control 

The document control feature allows you to add or delete documents, videos, images, and URLs 
to/from the record that you are on.   

 It is important to remember when adding documents on the desktop, the document is only 
linked to the asset in Lucity.  If the document is deleted from your computer, it will no longer 
be accessible from the Lucity system.  In addition, if the document is on your computer and not 
available to the network, other users will see that it is attached, but will not be able to view 
it. 

Relationship Button 
The Lucity systems rely on the integration of modules to 

efficiently record and analyze data. For example, the Hydrant 
Inventory module stores the Valve associated with a hydrant.  
It also shows stores information about its inspections.  
Thereby, the hydrant, valve, and inspections are related.  The 
Relationship Button displays any relationships of the current 
record to other modules. Next to each relationship name is a 
count of the number of related records.  Here’s a picture of 
some relationships to a Hydrant Inventory record: 

Clicking on one of the relationships will open the related record(s) in the other module. 

 

Toolkit 
Some modules have a Toolkit button  that has provides users with functions designed for 
specifically that module.  When the dialog opens, you can select a tool that you wish to execute.  For 
example, the Water Hydrant Flow Test module has this toolkit: 

 

The help file is a good resource for providing detailed information about the toolkits. 
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Customizing Toolbars 
The desktop allows users to select toolbars to display and customize.  This allows them to remove 
modules that they don't use, or arrange them to match their work flow. 

The display a toolbar, select one or more toolbars in the View menu: 

 

After selecting the toolbar, it will first display at the top of the desktop.  It can be moved to a 
different location on the screen by clicking on the bar at the far left end and dragging it to a new 
position: 

 

To customize the toolbar, right-click on it and select “Customize Toolbar”: 

 

Module buttons can be added, removed, moved up/down, and separated by a Separator by using the 
buttons in the Customize Toolbar dialog: 
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Help File 
The Lucity Help File is a very useful tool for finding out more information on any topic within the Lucity 
system.  To access the help file from the desktop, you can go to the Help menu and select “Help 
Topics”.  The help file requires an internet connection. 

You can run custom searches using any search criteria. For example, to find information about “Work 
Orders” on the desktop, click on the Lucity Desktop manual, type in “Work Orders” in the search field 
and click the magnifying glass to search for the related help topics.  You can click the links on the left 
side to view a topic related to Work Orders: 

 

You can also drill down on the Contents menu to find detailed information specific topics or modules: 

 

To view information about other applications and topics within the Lucity system, click the Help button 
in the upper right of the screen that will take you back to the main help page: 

 


